
 

 

 

 

To All Members and Market Participants 

 

Subject: Master Circular for Unique Client Code 

Various circulars have been issued from time to time on upload of information of Unique 

Client code to the Exchange. With a view to facilitate all members and market participants 

to comply with the current regulatory requirements and have access to the applicable 

guidelines at one place relating to the above, the Exchange has consolidated all the 

applicable circulars on Unique Client Code issued upto March 31, 2023.  

 

Members are advised to take note of the same and comply with these norms, in letter and 

spirit, on a continuous basis. In case of any detailed clarification required, Members are 

advised to refer to the respective circulars. 

 

For the convenience of members, circular is categorized as following:  

 

Part A Introduction to Unique Client Code 

Part B Reports Available 

Part C Consolidated List of Applicable Circulars 

 

In case of any inconsistency between the Master Circular and the applicable circulars, 

the content of the relevant circular shall prevail. 

 

Notwithstanding such rescission  

a. Anything done or any action taken or purported to have been done or contemplated 

under the rescinded guidelines before the commencement of this Master Circular shall 

be deemed to have been done or taken or commenced or contemplated under the 
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corresponding provisions of the Master Circular or rescinded guidelines whichever is 

applicable. 

b. The previous operation of the rescinded guidelines or anything duly done or suffered 

thereunder, any right, privilege, obligation or liability acquired, accrued or incurred under 

the rescinded guidelines, any penalty, incurred in respect of any violation committed 

against the rescinded guidelines, or any investigation, legal proceeding or remedy in 

respect of any such right, privilege, obligation, liability, penalty as aforesaid, shall remain 

unaffected as if the rescinded guidelines have never been rescinded. 

  

 

For and on behalf of   

National Stock Exchange of India Limited   

  

 

Shanti Idnani 

Associate Vice President 
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1800 266 0050 (select option 5) ignse@nse.co.in 
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UNIQUE CLIENT CODE  

PART A 

 

1. Introduction to Unique Client Code (UCC): 

 

SEBI vide its circular SMDRP/Policy/Cir-39/2001 dated July 18, 2001, had directed that 
it shall be mandatory to use unique client codes for all the clients. In order to comply 
with the above circular, it had been made mandatory for the trading members to upload 
the unique client codes for all their clients in the Exchange UCC database. 
 
Following are the checks to be done by the Trading members prior to upload of UCC 
in the UCI -Portal of Exchange 

I. Checks for PAN  

• The requirement of mandatory submission of PAN by clients for transactions in the 

securities market shall continue to apply, with permitted exemptions. 

• Members shall verify the PAN online using the Income Tax Database.  

• In case PAN is not seeded with AADHAAR before the date specified by the 

Government; it will not be considered as a valid PAN.  

 

II. Checks for mobile number and email ID  

• Members shall ensure that separate mobile number and email address is captured 

for all UCCs for Retail clients. However, after submitting a written declaration to 

Members, they can update common mobile number and email address of its family 

members. Family for this purpose has been defined as self, spouse, dependent 

parents and dependent children. 

• In cases where same mobile number / email ID is captured in more than one UCC 

account and written declaration for the family is not submitted to the Member, 

Members shall be required to send 30 days’ notice to their clients for submitting 

mobile number /email ID modification form / request letter for updating the same or 

family declaration. 

• Members shall ensure that the mobile numbers/ email addresses of Trading 

members /their employees or their Authorised Persons are not captured as client 

contact details.  

III. Proprietary account 

Trading Members shall be required to mandatorily upload PAN details for all ‘PRO’ 

(Proprietary account) codes. For this purpose, the trading member code shall be 

mentioned as Unique Client Code (UCC) and the valid PAN of the trading member 

shall be provided. 

Amendments to provisions in SEBI Circular dated September 16, 2016 on Unique 

Client Code (UCC) and mandatory requirement of Permanent Account Number 

(PAN). 

Exchange vide circular NSE/ISC/47598 dated March 10, 2021 stated that SEBI has 

issued circular No. SEBI/HO/CDMRD/DNP/CIR/P/2021/30 dated March 08, 2021, 

https://www.sebi.gov.in/legal/circulars/jul-2001/unique-client-code_17979.html


 

5 
 

 

stating that UCC is mandatory for commodity derivative segment. For this purpose, 

members shall collect after verifying the authenticity and maintain in their back-office 

the copies of Permanent Account Number (PAN) issued by the Income Tax (IT) 

Department, for all their clients. However, in case of e-PAN, members shall verify the 

authenticity of e-PAN with the details on the website of IT Department and maintain the 

soft copy of PAN in their records.” 

(Refer Circulars:  

• NSE/CMTR/2730 dated July 24, 2001 

• NSE/ISC/ 40305 dated February 25, 2019 

• NSE/ISC/47598 dated March 10, 2021 

• NSE/ISC/48165 dated May 03, 2021 

• SEBI/HO/CDMRD/DNP/CIR/P/2021/30 dated March 08, 2021 

• SMDRP/Policy/Cir-39/2001 dated July 18, 2001) 
 

Over the period, there has been considerable change in the structure of the UCC data 
captured by the Exchange. The latest file format is attached at Annexure A.  

 

• Upload of UCC through UCI-Online/API Module  

 

A facility has been provided to the trading members to upload the UCCs of their 
clients UCI-Online application and Application Programming Interface (API) module 
of Exchange. 
 
Format for upload (format provided as per Annexure A) has been made available to 
the trading members under the below mentioned menu option.  
o Member Portal>UCI Online>Help>User manual. 
o Member Portal>UCI Online>Help> API Document-UAT 

o Member Portal>UCI Online>Help> API Document-LIVE 

Links for API 

https://ims.connect2nsccl.com/api-reg/welcome 

https://uat.connect2nsccl.com/api-reg/welcome 

Links for UCI-Online 

https://ims.connect2nsccl.com/MemberPortal  

https://uat.connect2nsccl.com/MemberPortalRevamp/  

(For details of API, refer circulars NSE/ISC/47939 dated April 08, 2021) 

NSE/ISC/50476 dated December 01, 2021 

 

• Mandatory fields in Unique Client Code (UCC) w.r.t 6 KYC attributes 

 

In consultation with SEBI and as per NSE circular no. NSE/ISC/47869 dated April 

01, 2021, NSE circular NSE/ISC/48165 dated May 03, 2021, NSE/ISC/49094 dated 

July 28,2021 and NSE/ISC/51754 dated March 24, 2022, UCCs which are 6 KYC 

compliant shall be permitted to trade. 

 

Trading Members are to upload the below client details in order to make the UCC 

compliant for trading on the Exchange. 

https://www.sebi.gov.in/legal/circulars/jul-2001/unique-client-code_17979.html
https://ims.connect2nsccl.com/api-reg/welcome
https://uat.connect2nsccl.com/api-reg/welcome
https://ims.connect2nsccl.com/MemberPortal
https://uat.connect2nsccl.com/MemberPortalRevamp/
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o Name (Name as per PAN), Complete address (including PIN code No. in case 

of address of India), PAN, valid Mobile number, Valid email-id, Income 

details/range.  

o Custodian details updated for clients availing custodian services.  

o PAN verification status of the client is Approved.  

o Further, to undertake ‘Buyback’ of a particular security, the UCC code created 

as “BUYBACK***” also needs to be compliant with the above guidelines.  

o PAN-Aadhaar seeding having status as Y (Aadhar Seeding is successful) for 

eligible client categories 

o UCC should be in “Active” Status 

o Nomination of the client to be updated for eligible client categories 

 

Apart from these fields any other field which is mandatory as per the file format 

and category shall be applicable 

 

Once a UCC satisfies all the above requirements, the UCC shall be permitted to 

trade. File format is attached as Annexure A. 

 

(Refer Circulars:  

• NSE/ISC/47869 dated April 01, 2021 

• NSE/ISC/48165 dated May 03, 2021 

• NSE/ISC/49094 dated July 28, 2021 

• NSE/ISC/49106 dated July 29, 2021 

• NSE/ISC/50476 dated December 01, 2021 

• NSE/ISC/50802 dated December 28, 2021 

• NSE/ISC/51355 February 18, 2022 

• NSE/ISC/51754 dated March 24, 2022 

• NSE/CMTR/52770 dated June 28, 2022 

• NSE/ISC/52722 dated June 23, 2022 

• NSE/CMTR/52770 dated June 28, 2022)  

 

• UCC Modification: 

 

Modification in Single UCC: 

Trading members can modify/update the client details in existing UCC through 

Query client. 

 

Path: Member Portal>Client detail>Query Client>Modify 

 

Bulk Modification file upload in UCC system 

In order to modify/update the client details in multiple existing UCCs, a bulk 

modification file format is also made available to the trading members in the UCI 

portal. Format is attached as Annexure B 

 

Path: Member Portal>Client detail> Bulk Modification> File Upload 

 

(Refer Circulars: 
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• NSE/ISC/49289 dated August 13, 2021 

• NSE/ISC/50476 dated December 01, 2021) 
 

• Unfreeze Option 
 

Single Unfreeze Request 
In order to update the name, category, PAN, PAN-AADHAAR seeding status for a 
single client trading member can place the request under the below mentioned Path 
 
Path: Member Portal >Other options>Unfreezing request>New Request 

 
Bulk Unfreeze Request 
Trading Members can update the name, category, PAN, PAN-AADHAAR seeding 
status of their clients through bulk unfreeze option in UCI portal. Format for bulk 
unfreeze is attached as Annexure C. 
 
Path: Member Portal>Other options>Unfreezing request>Bulk upload-unfreezing 
 

• Client Status 
 

Trading Members can update the client status of their clients as Active, Inactive and 
Closed in UCI portal 

 
Single client status update 
  

For single client tatus update, trading members can update the client status of their   

clients on the following path 

 

Path: UCI Online > Client Details > Update Client Status. 

 

Bulk Client status update 

The Trading Members can upload the Client status details for more than one client 

through file upload on the following path. Format attached as Annexure E 

Path: UCI Online > Client Details >Upload Client Status 

 

• PAN_EXEMPT 

 

o Exchange circular NSE/INVG/2006/8288 dated December 27, 2006 states that 

“SEBI vide its circular no. MRD/DoP/Dep/SE/Cir-13/06 dated September 26, 

2006 has exempted certain entities like U.N. entities/multilateral agencies and 

investors residing in the State of Sikkim from mandatory PAN submission. With 

effect from January 2, 2006, details of such clients can be uploaded to the 

Exchange using the words “PAN_EXEMPT” (in capitals, exactly in the same 

format) in the PAN number column. Exemption will be allowed only based on 

supporting documents in proof of the PAN exempt status”  

 

o Subsequently, SEBI vide Circular MRD/DoP/Cir-20/2008 dated June 30, 2008, 

point 3 has clarified that “PAN may not be insisted in the case of Central 



 

8 
 

 

Government, State Government, and the officials appointed by the courts e.g. 

Official liquidator, Court receiver etc. (under the category of Government) for 

transacting in the securities market.” Hence, Exchange circular 

NSE/INVG/2008/10921 dated July 1, 2008 states that the words “PAN_EXEMPT” 

be mentioned in the PAN field along with providing relevant proofs on UCI Online. 

 

This is an Online document submission facility for members to submit document 

proof in case of clients appearing in the PAN_EXEMPT category.   

 

In relevant scenarios, Trading Members are required to upload PAN as 

PAN_EXEMPT through insert details or upload details successfully and then attach 

the proof type through this facility. Member can submit the proof type for 

PAN_EXEMPT client. 

 

UCC which are PAN_EXEMPT shall be mapped with the demat account of the 

client. 

Path: Member portal>Other options>PAN Exempt>New Submission 

(Refer Circulars: 

• NSE/INVG/2006/8288 dated December 27, 2006 

• NSE/INVG/2008/10921 dated July 1, 2008 

• SEBI circular MRD/DoP/Dep/SE/Cir-13/06 dated September 26, 2006  

• SEBI circular MRD/DoP/ Cir- 20/2008 dated June 30, 2008) 

 
2. Mapping of Unique Client Code (UCC) with demat account of the clients. 

 

SEBI vide its circular no. SEBI/HO/MIRSD/DOP/CIR/P/2019/136 dated November 15, 

2019 has made it mandatory to map clients’ UCC with their demat accounts. Hence, 

for mapping of UCC with the demat account of the clients, the following mechanism 

has been implemented:  

1. UCC allotted by the TM to the client shall be mapped with the demat account of 

the client.  

2. A client may trade through multiple TMs in which case each such UCC shall be 

mapped with one or more demat account(s). 

3. Stock Exchanges shall share the UCC data with the Depositories which shall 

include the PAN, segment, TM/CM code and UCC allotted. Such UCC data shall 

be shared with the Depositories on a one-time basis by November 30, 2019, 

and subsequently incremental data in respect of new UCCs created, shall be 

shared on a daily basis.  

4. Depositories shall map the UCC data in the demat account based on the PAN 

provided in the UCC database. 

5. Clients may make a request to their depository participants to delink or add UCC 

details which shall be processed by the Depository through depository 

participants. Before any addition of UCC in the demat account, the Depositories 

shall validate the same with the Stock Exchanges / client. 

https://www.sebi.gov.in/legal/circulars/nov-2019/mapping-of-unique-client-code-ucc-with-demat-account-of-the-clients_44983.html
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6. Stock Exchanges and Depositories shall have a mechanism in place to address 

clients’ complaints with regard to UCC mapping with their demat accounts. 

7. Stock Exchanges and Depositories shall have a mechanism in place to ensure 

that inactive, non-operational UCCs are not misused and also a mechanism to 

ensure that inactive, non-operational UCCs are weeded out in the process of 

mapping clients’ UCC with their demat account. 

(Refer Circulars:  

• NSE/ISC/42678 dated November 18, 2019 

• SEBI/HO/MIRSD/DOP/CIR/P/2019/136 dated November 15, 2019)  

 

3. Nomination for Eligible Trading and Demat Accounts 

 

As per SEBI circular no. SEBI/HO/MIRSD/RTAMB/CIR/P/2021/601 dated July 23, 

2021, NSE circular NSE/INSP/49042 dated July 23, 2021 and NSE/ISC/50476 dated 

December 01, 2021, trading members are required to obtain Nomination from their 

clients and update the same in the UCC system of the Exchange. In order to comply 

with the above circular, Trading Members are required to activate new Trading 

accounts only upon receipt of Nomination details in formats as mention by SEBI. 

Further for existing clients trading members are required to obtain the choice of 

nomination and update the same in the UCC system of the Exchange within the 

timelines as prescribed by SEBI. Format for updating the choice of nomination is 

attached as Annexure A and Annexure B. 

Path: Member portal>UCI Online> Bulk modification> File upload. 

 

(Refer Circulars:  

• NSE/INSP/49042 dated July 23, 2021 

• NSE/ISC/50476 dated December 01, 2021 

• NSE/INSP/51438 dated February 24, 2022 

• NSE/ISC/55473 dated February 02, 2023 

• NSE/ISC/56112 dated March 23, 2023 

• NSE/ISC/56153 dated March 28, 2023 

• NSE/ISC/56728 dated  May 16, 2023 

• NSE/ISC/57234 dated June 22, 2023 

• SEBI/HO/MIRSD/RTAMB/CIR/P/2021/601 dated July 23, 2021 

• SEBI/HO/MIRSD/MIRSD_RTAMB/P/CIR/2022/23 dated February 24, 2022) 

 

4. Aadhaar seeding with PAN 

 

The Government of India in its Circular No. 7 dated 2022 and press release dated 

March 28, 2023 has made it mandatory to link the PAN with Aadhaar, failing which 

the PAN shall become inoperative as per the timelines provided by in their 

notifications. In view of the above, trading members to ensure that the PAN is seeded 

with Aadhaar and the same is updated in the UCC system of the Exchange in order 

to place orders. Format is attached as Annexure C. Below is the path to place 

Unfreeze Option on UCI Online 

https://www.sebi.gov.in/legal/circulars/nov-2019/mapping-of-unique-client-code-ucc-with-demat-account-of-the-clients_44983.html
https://www.sebi.gov.in/legal/circulars/jul-2021/nomination-for-eligible-trading-and-demat-accounts_51313.html
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New Request option: 
Below is the path to place Unfreeze Option for Single UCC on UCI Online: 
Path: UCI Online > Other Options > Unfreeze Request > New Request 
 
The user is given an option to provide unfreeze request through New Request option. 
Client code and segment have to be provided by the user. Client Name, PAN and 
category will be populated automatically. They have to select Aadhar-PAN Seeding 
status from the drop down of Reason for unfreezing and submit. 
 
Bulk Upload Unfreezing 
Below is the path to place Bulk Unfreeze Option on UCI Online:  
Path: UCI Online > Other Options > Unfreeze Request > Bulk Upload-Unfreezing 
 

(Refer Circulars:  

• NSE/ISC/48165 dated May 03, 2021 

• NSE/ISC/51755 dated, March 24, 2022 

• NSE/ISC/51828 dated March 30, 2022 

• NSE/ISC/55472 dated February 02, 2023 

• NSE/ISC/56173 dated March 28, 2023 

• NSE/ISC/56914 dated June 01, 2023 

• NSE/ISC/57051 dated  June 13, 2023 

• NSE/ISC/57267 dated June 26, 2023) 

 

5. Multiple UCC:  

 

Trading Members to allot only one UCC to an individual client and ensure that only one 

UCC with “Active” status is retained in the exchange system. It may be noted that the 

above requirement will not cover codes for Institutional clients / NRI / PMS / Statutory 

Bodies / Custodian settled clients / codes allotted as “BUYBACK”, codes allotted under 

the trading member PAN and any other codes falling under exempted category. 

(Refer Circulars:  

• NSE/INVG/2002/3690 dated October 18, 2002 

• NSE/ISC/ 48573 dated June 12, 2021 

• NSE/ISC/49034 dated July 23, 2021 

• NSE/ISC/52991 dated July 15, 2022)  

 

 

6. Disclosures by Stock Exchanges for Commodity Derivatives 

 

As per SEBI circular No. SEBI/HO/CDMRD/DNPMP/CIR/P/2019/08 dated January 04, 

2019, Exchange is required to display commodity wise details of the positions held by 

various categories of clients viz. Farmers / FPOs, Value Chain Participants (VCP), 

Proprietary Traders (applicable to Member's OWN account), Domestic Financial 

Institutional Investors, Foreign Participants and Others. Accordingly, the members to 

obtain self-declaration from their clients on commodity wise categorization and provide 

the said information of client categorization to the Exchange through file upload facility. 

SEBI/HO/CDMRD/DNPMP/CIR/P/2019/08
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The Bulk File Upload facility has been made available for the trading members on 

Member Portal - UCI Online. Members are requested to adhere to the requirement of 

the categorization of clients trading in commodity segment for each commodity prior to 

trading. 

 

Trading Member to update the details in the format as attached at Annexure D on the 

following path: 

Member Portal-UCI Online-Others- Commoditywise_Category.  

 

(Refer Circulars:  

• NSE/ISC/46405 dated November 20, 2020 

• NSE/ISC/46471 dated November 26, 2020 

• SEBI/HO/CDMRD/DNPMP/CIR/P/2019/08 dated January 04, 2019) 

 

7. Adherence to KYC Requirements 

 

This is further to the SEBI circular CIR/MIRSD/16/2011 dated August 22, 2011, 

regarding norms prescribed for Simplification and Rationalization of Trading Account 

Opening Process and Exchange circulars NSE/INVG/22755 dated February 15, 2013 

and NSE/ISC/42940 dated December 18, 2019, regarding updating of client address 

in the UCC system of the Exchange. As per the account opening requirement, the name 

and address mentioned on the KYC form should match with the documentary proof 

submitted by the client. 

In view of the above, the Trading Members are required to ensure that the details 

submitted to the UCC database/system of the Exchange is matching with the 

documentary proof provided by the client. Trading members are required to do 

adequate verification of documents while onboarding clients and updating of details in 

UCC database/system of the Exchange. In accordance with the above, trading 

members are required to send the identity and address proof of all the newly onboarded 

clients (irrespective of whether PAN has been submitted by account holder or not) to 

the Exchange, where the correspondence or permanent address of the client is 

‘Sikkim’. The aforesaid documents should be sent vide email on uci@nse.co.in. In case 

of any deviations observed by the Exchange during the scrutiny of records, the same 

shall be informed to the trading member for necessary corrective actions.  

However, in absence of corrective action by the trading member within 10 days from 

the date of intimation of the discrepancy, then trading member shall mark such account 

as closed with immediate effect and discrepant UCCs shall be considered as non-

compliant and not permitted to trade. The Exchange may take any other disciplinary 

action that it may deem fit. Further, the Trading Members are required to maintain 

additional diligence for all existing and new clients, by capturing the details of devices 

(Computer/Tablet/Mobile including Executable Applications, Browser based Apps, 

Mobile Apps) used to place/modify/cancel orders by the clients based out of Sikkim to 

verify if the orders are placed from ‘Sikkim’ Trading Members are requested to take 

note and comply with the above guidelines. 

 

 

https://nseindialimited.sharepoint.com/sites/Regulatory2/regulatory/Investigationuci/MASTER%20CIRCULAR/SEBI/HO/CDMRD/DNPMP/CIR/P/2019/08
https://www.sebi.gov.in/legal/circulars/aug-2011/simplification-and-rationalization-of-trading-account-opening-process_20483.html
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(Refer Circulars:  

• NSE/ISC/53233 dated August 08, 2022 

• NSE/INVG/22755 dated February 15, 2013 

• NSE/ISC/42940 dated December 18, 2019 

• SEBI CIR/MIRSD/16/2011 dated August 22, 2011) 

 

8. Buyback Trades: 
 
In order to undertake ‘Buyback’ of a particular security, members are required to place 

a buyback order by specifying the initial seven characters as, “BUYBACK***”. 

A UCC Code as “BUYBACK***” needs to be created by the trading member in the 

UCC system of exchange and the same shall be compliant with the 6 KYC attributes. 

SMS and Email to Investors (seller) for participating in Buy Back trades 

Exchange sends SMS and Email to to investor (seller) intimating them about their sell 

orders matched against buyback orders (if any) of the Company on the Exchange 

trading platform. 

In view of the above, trading Members shall ensure that the mobile no. and email id 

of their clients updated in UCC database of the Exchange is correct and valid to 

receive the communication/ intimation of the trade(s) matched against buyback of 

shares. 

(Refer Circulars:  

• NSE/ISC/48147 dated April 30, 2021 

• NSE/CMTR/52770 dated June 28, 2022) 
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PART B 

                                          REPORT 

 

1. Full File Report 

 

The member can place request for full data of client codes uploaded by them with 

the     exchange till date through “Request” option. The same shall be available 

under “View Full File’’ option on the next working day. 

 

The member can also place request for client codes created by selecting respective 

period and or segment or full dump for all segments. Member can raise only 5 

requests in a day and if period is selected it should not be more than 1 year. 

           A requisite detail needs to be submitted through "Request" option. 

           Path: Member portal>UCI online> Download>Full File>Request 

The dump is being made available on the next working day: 

Path: Member portal>UCI online> Download>Full File>View Full File. 

Refer Sheet A of Annexure F 

 

2. Trading Status Report 

 

UCCs identified as compliant by the Exchange at 22.00 hrs. on the previous day 

shall be considered as permitted to trade for the next trading day. A segment wise 

report of UCCs which are permitted to trade by the Exchange is provided on daily 

basis. The said report is provided at two intervals i.e. UCCs permitted to trade as at 

14:30 hrs and 22:00 hrs.  

 

The details of the report are as provided below:  

• Report Name: SEG_TMCODE_UCC_TRADING_STATUS_DDMMYYYY_nn  

 

Path: Extranet  

Segment Path 

CM /Reports 

FO /FAOFTP/Reports 

CDS /CDSFTP/Reports 

CO /COMTFTP/Reports 

DEBT /DEBTFTP/Reports 

SLB /SLBFTP/Reports 

 

The trading members to refer the UCCs permitted to trade as stated in the below 

reports, prior to order placement  

 

• Batch Number 01 for the UCCs permitted to trade as at 14:30 hrs 

• Batch Number 02 for the UCCs permitted to trade as at 22:00 hrs  
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It may further be noted, that under normal circumstances, the UCCs appearing in 

the Batch 2 report shall be considered for order placement on the next trading day. 

However, in the event of any exigencies, the UCCs appearing under the Batch 1 

report should be considered for order placements on the subsequent trading day. 

 

The non-compliant UCCs on fulfilment of the conditions specified above and on due 

verification /approval of Exchange shall be considered compliant and permitted to 

trade by the Exchange only on the next trading day.  

 

In order to facilitate the trading members, the status of UCCs marked as permitted 

to trade is being provided in the following existing reports  

 

1. Mandatory fields  

2. PAN verification status 

Refer Sheet B of Annexure F 

 

3. MNRL Report 

 

SEBI, vide its letter No. SEBI/HO/MIRSD/DOP/OW/P/2020/11531/1 dated July 9, 

2020 had intimated the Exchange that Telecom Regulatory Authority of India (TRAI) 

has made available a list of permanently disconnected mobile numbers i.e. Mobile 

Number Revocation List (MNRL) on their website in a secured manner to enable 

the interested parties to clean up their database, thereby not sending any further 

communication on such mobile numbers. 

 

For Member’s convenience, every month Exchange downloads a Member wise 

report which will provide the list of client codes whose Mobile Number is appearing 

under the MNRL list for the month. The report shall be made available by 15th of 

every month on below mentioned path:  

 

UCI Online-Download-Report for disconnected Mobile numbers 

 

Trading Members to check this report and wherever necessary, update the mobile 

numbers of their clients in UCI database after confirming/verifying the same with 

the respective client so that the correct mobile numbers are maintained in UCI 

database. 

           Refer Sheet C of Annexure F 

 

4. PAN status report 

 

To facilitate members to check the status of UCCs uploaded with respect to PAN 

verification by the Exchange, the Exchange has provided download facility in UCC 

system wherein the trading members can download the UCC records created for 

any 10 days. The downloaded file shall provide the information about PAN 

verification status viz. Approved / Incorrect / Pending for verification. 
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Path: UCI Online-Other option-PAN Status report. 

 

Refer Sheet D of Annexure F 
 

5. Mandatory report 

 

Trading Member wise report of the mandatory fields for all the UCC uploaded by 

the trading member in the UCC system of the Exchange shall be provided, to 

facilitate trading members to identify and update the records, where mandatory 

fields are blanks or having invalid/incomplete details. This shall also include the 

status of PAN – Aadhaar Seeding 

 

Path- Member Portal>UCI Online>Download>Report for Mandatory Fields 

 

Refer Sheet E of Annexure F 
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PART C- Consolidated List of Applicable Circulars 

 

Circular References  

 

Sr 
No. 

Subject Circular References (Both SEBI & NSE) 

1 Introduction to Unique 
Client Code 

• SEBI/HO/CDMRD/DNP/CIR/P/2021/30 dated 

March 08, 2021 

• SMDRP/Policy/Cir-39/2001 dated July 18, 2001 

• NSE/CMTR/2730 dated July 24, 2001 

• NSE/ISC/ 40305 dated February 25, 2019 

• NSE/ISC/47598 dated March 10, 2021 

• NSE/ISC/48165 dated May 03, 2021 

2 Upload of UCC through 
UCI-Online/API Module  

• NSE/ISC/47939 dated April 08, 2021 

• NSE/ISC/50476 dated December 01, 2021 

3 Mandatory fields in 
Unique Client Code 
(UCC) 

• NSE/ISC/47869 dated April 01, 2021 

• NSE/ISC/48165 dated May 03, 2021 

• NSE/ISC/49094 dated July 28, 2021 

• NSE/ISC/49106 dated July 29, 2021 

• NSE/ISC/50476 dated December 01, 2021 

• NSE/ISC/50802 dated December 28, 2021 

• NSE/ISC/51355 February 18, 2022 

• NSE/ISC/51754 dated March 24, 2022 

• NSE/CMTR/52770 dated June 28, 2022 

• NSE/ISC/52722 dated June 23, 2022 

• NSE/CMTR/52770 dated June 28, 2022 

4 UCC Modification • NSE/ISC/49289 dated August 13, 2021 

• NSE/ISC/50476 dated December 01, 2021 

5 PAN_EXEMPT • SEBI circular MRD/DoP/Dep/SE/Cir-13/06 

dated September 26, 2006 

• SEBI circular MRD/DoP/ Cir- 20/2008 dated June 

30, 2008 

• NSE/INVG/2006/8288 dated December 27, 2006 

• NSE/INVG/2008/10921 dated July 1, 2008 

6 Mapping of Unique 

Client Code (UCC) with 

demat account of the 

clients. 

• SEBI/HO/MIRSD/DOP/CIR/P/2019/136 dated 

November 15, 2019 

• NSE/ISC/42678 dated November 18, 2019 

7 Nomination for Eligible 

Trading and Demat 

Accounts 

 

• SEBI/HO/MIRSD/RTAMB/CIR/P/2021/601 dated 

July 23, 2021 

• SEBI/HO/MIRSD/MIRSD_RTAMB/P/CIR/2022/23 

dated February 24, 2022 

• NSE/INSP/49042 dated July 23, 2021 

https://www.sebi.gov.in/legal/circulars/jul-2001/unique-client-code_17979.html
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Sr 
No. 

Subject Circular References (Both SEBI & NSE) 

 • NSE/ISC/50476 dated December 01, 2021 

• NSE/INSP/51438 dated February 24, 2022 

• NSE/ISC/55473 dated February 02, 2023 

• NSE/ISC/56112 dated March 23, 2023 

• NSE/ISC/56153 dated March 28, 2023 

• NSE/ISC/56728 dated May 16, 2023 

• NSE/ISC/57234 dated June 22, 2023 

8 Aadhaar seeding with 

PAN 

 

• NSE/ISC/48165 dated May 03, 2021 

• NSE/ISC/51755 dated, March 24, 2022 

• NSE/ISC/51828 dated March 30, 2022 

• NSE/ISC/55472 dated February 02, 2023 

• NSE/ISC/56173 dated March 28, 2023 

• NSE/ISC/56914 dated June 01, 2023 

• NSE/ISC/57051 dated June 13, 2023 

• NSE/ISC/57267 dated June 26, 2023 

9 Multiple UCC 

 

 

• NSE/INVG/2002/3690 dated October 18, 2002 

• NSE/ISC/ 48573 dated June 12, 2021 

• NSE/ISC/49034 dated July 23, 2021 

• NSE/ISC/52991 dated July 15, 2022 

10 Disclosures by Stock 

Exchanges for 

Commodity Derivatives 

• SEBI/HO/CDMRD/DNPMP/CIR/P/2019/08 dated 

January 04, 2019 

• NSE/ISC/46405 dated November 20, 2020 

• NSE/ISC/46471 dated November 26, 2020 

11 Adherence to KYC 

requirements 
• SEBI CIR/MIRSD/16/2011 dated August 22, 2011 

• NSE/ISC/53233 dated August 08, 2022 

• NSE/INVG/22755 dated February 15, 2013 

• NSE/ISC/42940 dated December 18, 2019 

12 MNRL • SEBI/HO/MIRSD/DOP/OW/P/2020/11531/1 dated 

July 9, 2020 

• NSE/ISC/45168 dated July 29, 2020 

• NSE/ISC/47834 dated March 31, 2021 

13 Buyback Trades • NSE/ISC/48147 dated April 30, 2021 

• NSE/CMTR/52770 dated June 28, 2022 

 

 

https://nseindialimited.sharepoint.com/sites/Regulatory2/regulatory/Investigationuci/MASTER%20CIRCULAR/SEBI/HO/CDMRD/DNPMP/CIR/P/2019/08

